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About This Handbook

The first edition of this handbook was created by then Writing Center Director Cheryl Prentice 
in response to student and faculty requests for an introduction to the Publication Manual of the 
American Psychological Association, 6th edition, better known and referred to in this handbook 
as “the APA manual.” In 2018, Writing Center staff updated the resource to be more accessible. 

Some tips and notes:
 

• Throughout the booklet you will see bracketed numbers that refer to relevant sections 
of the APA manual. For example, [8.03, p. 30] would mean you can look in the APA  
manual in section 8.30 on page 30 for additional information. 

• This handbook is not formatted in APA Style, as APA was designed for academic papers, 
not instructional manuals. 

• The booklet is not intended to replace the APA manual but rather will help you interpret 
the manual and call your attention to some of its most important features. You should 
always refer back to the APA manual as needed for more detailed information. 

• While we will provide you with APA Style guidelines and rules here,  
every instructor has his/her own approach to APA Style, and you should  
always follow assignment instructions first. When in doubt, ask your  
instructor for his/her preference.

• This booklet is interactive, so you’ll find links throughout. In addition, you can  
use the controls on the bottom of each page to move throughout the document. 

© 2018 The Writing Center, Saint Mary’s University of Minnesota Schools of Graduate and Professional Programs
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Part One: Formatting

A Word on APA Format and Instructor Requirements
The following formatting guidelines adhere to the 6th edition of the APA manual; however, occasionally programs 
at SGPP will require departures from APA style. Ask your program faculty if they require any departures. 

Alignments
Alignment is set at the left margin for all text except some headings and the title page.  Text should align evenly 
on the left margin but be ragged on the right margin, like the text on this page.  Indent the first line of a  
paragraph 0.5 inches (1 Tab).

Font [8.03]
The standard font for student papers at Saint Mary’s University SGPP is Times New Roman size 12.  Do not use  
underlining or all capitals unless your instructor specifies these.  Use boldface for headings only.  Keep the font the 
same throughout the paper.         

Headings [3.02-3.03] 
Headings help both the reader and the writer follow the paper’s organizational structure. APA headings follow a 
pattern of five levels. Most papers will only require the use of one to three levels. A capstone paper may require 
four levels, and the fifth level is reserved for doctoral dissertations. 

The following are not considered headings: the title of the paper, the References page title, the Abstract title, the 
Table of Contents title, and the Appendix titles. Type any of these titles by centering them, without boldface or 
italics, and capitalizing the first letter of major words [4.15]. 

Headings should not be complete sentences or questions, e.g. Characteristics of Transformational Leaders not 
What are the Characteristics of Transformational Leaders? 

Headings are arranged in the following hierarchy: 

Level 1 Heading

 The Level 1 heading is bold, centered, and title case. Use Level 1 headings to  

subdivide the major sections of your paper. 

Level 2 Heading

 The Level 2 heading is bold, left-aligned, and title case. Use Level 2 headings to 

subdivide Level 1 headings. 

 Level 3 heading. The Level 3 Heading is bold, indented 0.5 inches, sentence case, 

and is followed by a period. 

 Level 3 heading. Use Level 3 Headings to subdivide Level 2 Headings.

 Level 4 heading. The Level 4 Heading is bold, indented 0.5 inches, sentence case, 

italicized, and is followed by a period. 

 Level 4 heading. Use Level 4 Headings to subdivide Level 3 Headings.

You can’t subdivide a section 
by one. Note that there are two 
Level 3 headings here. 

For Level 3, 4, and 5 headings, the 
paragraph starts right after the period of 
the heading. 
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Headings [3.02-3.03], continued
Imagine you are writing a paper about your favorite shoes.Your headings might look like the sample here.
 

FAVORITE SHOES  2

My Favorite Shoes

 While we all wear shoes, everyone has their favorite pair or style of shoe. This paper 

will explain the two categories of shoes that I own—casual and dress—and detail my favorite 

kinds of shoes within each category. 

Casual Shoes

 There are many types of casual shoes, but my favorite types are sneakers and sandals. 

Sneakers

 Sneakers are also known as tennis shoes and runners. Sneakers usually have rubber sole 

and can be used as casual shoes or for exercise. 

 Casual sneakers. I wear casual sneakers for a lot of occasions, and I probably have at 

least ten different pairs. I have slip-on sneakers made of leather, canvas, and even gold lame. I 

like to wear my slip-on sneakers with skinny jeans or long skirts. I have four pairs of lace-up, ca-

sual sneakers. All four pairs are made by Converse, and I like to wear them with miniskirts, jeans, 

and summer dresses.

 Exercise sneakers. This kind of sneaker is made especially for exercise. There are a lot 

of different kinds of exercise sneakers, and each kind is made for a particular kind of workout. 

 Running shoes. I like to wear lightweight sneakers for running. My running shoes are 

made by Merrill and have almost no padding. 

 Weight-lifting shoes. My weight-lifting shoes are actually a pair of old Converse  

sneakers. 

 Cross-training shoes. I wear cross-training shoes when I take aerobics classes. These

Your title is not a heading and 
should not be bold.

This is a Level 1 heading, so it is centered, bold, and title case.

This is a Level 2 heading, so it is 
aligned left, bold, and title case. Since 
we must use at least two of each level 
of heading, another Level 2 heading 
might be Sandals. This would divide 
Casual Shoes into two subsections.

This is a Level 3 heading, so it is bold, 
indented, sentence case, and ends 
with a period. 

Note that the paragraph begins right after the period of Level 3 headings.

There are three Level 4 
headings here. As mentioned 
on the previous page, most 
papers won’t have Level 
4 headings; however, you 
might use them in longer 
papers. 

Headings in an Appendix  [2.13]
If your paper contains an appendix [2.13], type the word Appendix as you would type the title of your paper  
(centered, not boldfaced or italicized, major words capitalized, [p. 39]). The title of the appendix is separate from 
any headings used within the appendix. If headings are used within an appendix, follow heading guidelines used in 
the paper, beginning with Level 1. 

Introduction and Conclusion Headings: Bold or not? 

Since every paper starts with an introduction, APA does not include a heading for the introduction; however, your 
instructor may require one. 

On the other hand, you should include a Level 1 heading for your conclusion since it is needed to indicate a division 
from the previous heading. You can learn more about headings here. 

FAQS

http://blog.apastyle.org/apastyle/2011/04/how-to-use-five-levels-of-heading-in-an-apa-style-paper.html
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Orphan Headings
Headings that stand alone on a line can get separated from their text when they are at the bottom of a page.  
Although the APA manual shows orphan headings in its sample papers (pp. 41-59), most people prefer to avoid 
them (see “Chapter Three: Microsoft Word for APA” for formatting instructions). 

Indents [8.03]
Indent the first sentence of each paragraph 0.5 inches (one Tab space).  All other lines of the paragraph wrap to 
the left margin, as in this paragraph. 

Indent blocked quotes (40 words or more) 0.5 inches on the left side only. Do not indent the first line of the 
quote. For example:

music on cell phones, and checking in with parents on Facebook. Bucksch et al. (2016) discussed 

the normalization of screen-time behaviors: 

 Clearly, screen time behaviors (STBs) form an important part of young people’s leisure 

time. With continuous technological advances, the choice of innovative and attractive 

devices supports high levels of screen time [...]. The availability of screens, ready access to 

the Internet, and the increasing importantance of social media in young people’s lives has 

normalized STBs across the world. (p. 422)

This block quotation is indented 
0.5 inches.

Line Spacing [8.03]
Double-space all lines in the paper, including References page entries and blocked quotes, unless your instructor 
specifies otherwise.  The first line of each page (except title page) begins at the top margin.  Maintain one double 
space after headings and between paragraphs.

Use the double-space setting of the word processor.  Do not double-space manually by pressing the Enter key twice 
between lines.

Margins [8.03]
Set margins at 1 inch on all sides unless instructed otherwise. Many word processors set the default margin at 1.25 
inches, so you may need to reset the margins to 1 inch.  

Page Numbers [8.03, p. 230]
Count the title page as page 1 of the document. Place page numbers at the top right corner, 0.5 inches from the 
top (inside the header).  If your program requires a running head, place it inside the header at the left hand  
margin, 0.5 inches from the top edge. 

N
O

TE
S
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Paper [5.01]
Use 8-1/2” x 11” white paper.  All papers should be word-processed, one side only.

Spacing after Punctuation [4.01] 
In general, insert one space after every mark of punctuation. However, the APA manual recommends that you  
insert two spaces after punctuation that ends a sentence.  However, do not insert a space inside quotation marks 
and parentheses. Note the following examples:

Byer advocated a “go-it-alone” position in the conflict. 

Cole introduced the proposal (as recommended) and took a vote. 
There aren’t spaces between the text and parentheses. 

There aren’t spaces between the text and quotation marks. 

When typing an em dash or en dash [4.13], put no space either before or after them. To create an em dash, use 
two hyphens, which Microsoft Word will automatically turn into an em dash (if no space is left before or after 
them). To create an en dash, type a single hyphen (again, with no space before or after). 

The goal of this study—to find a student–centered approach to classroom management—

changed during the observation process. 

This is an em dash and is used 
to set off a parenthetical idea. 

This is an en dash (hyphen) and is most often used to connect 
two words when they are being used as an adjective.

Title Page
The APA manual describes a title page for a manuscript submitted for publication.  That style of title page is not 
necessarily appropriate for student papers.  If your program or your instructor gives you a sample title page, use 
that.  Otherwise use the sample text provided here.

STBS AND TEENS 1

The Effects of Screen Time Behaviors on Adolescents 

Sally Student

Saint Mary’s University of Minnesota

PSY690 Early Childhood Development 

Sam Smith, Instructor 

May 4, 2017

Your title

Your name

The name of the class

Your instructor’s name

The date of submission

The name of the university and school

Some programs have their own title page requirements. Please follow title page templates posted on the                      
Writing Center’s website at tcwrite.smumn.edu.
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Titles: Formatting  [2.01, 4.07, 4.15, 6.29]
Titles follow special formatting rules when they appear on an APA References page, which you can see in the chart 
below. Normally, titles of works cited do not appear in the text of your paper; however, if you do use a published 
title in your paper, follow the formatting rules below. 

The general rule for capitalizing words in titles used in your text is to capitalize major words.  We call this “title 
case” (“sentence case” is when we capitalize like in a sentence—the first word, proper nouns, and words after a 
colon). Major words are all words except coordinating conjunctions, articles, and short prepositions (fewer than 
three words). Do not capitalize the following:  

Coordinating Conjunctions: for, and, nor, but, or, yet
Articles (not capitalized): a, an, and, the
Short Prepositions: as, at, by, for, in, of, off, on, out, to, up

Examples: 

Forgiven but Not Forgotten 

“The Cambridge Spelling Report: Help or Hoax?”

The Logic and Rhetoric of Exposition 

“But” is a coordinating conjunction, so 
it isn’t capitalized here.

Always capitalize the first word after 
a colon. 

Punctuation tip: The quotation marks 
come outside the punctuation. 

You should capitalize coordinating 
conjunctions, articles, and short 
prepositions if they are the first word 
in a title. 

Using Bullets [3.04]
The APA manual allows the use of bullets, rather than numbers, for vertical lists when the order of items is not a 
factor (see “Chapter Three: Microsoft Word for APA” for formatting instructions). Bulleted lists summarize.  They 
should not replace a detailed explanation or commentary.

• Items in bulleted lists must be grammatically parallel [p. 86].
• Bulleted lists are double-spaced like the rest of the text.

Using Numbers in a List [3.04]
Use numbers instead of bullets when the order of the items is important—for example, in presenting a set of  
ordered steps in a process.  
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Using Lettered Series Within a Paragraph or Sentence [4.03; p. 64]
When a series or list of items appears within a sentence or paragraph, the items can be—but don’t have to be—             
designated by letters in parentheses. 

Researchers divided participants into four groups on the basis of age, gender, height, and weight 

(Johnson et al., 2014). 

The participants were given (a) the trial mediciation, (b) no drugs, or (c) a placebo (Johnson et al., 

2014).

Unlettered Seriation 
in a Sentence

Lettered Seriation 
in a Sentence or 

Paragraph

How do I format my appendices? 

An appendix is a document that you attach at the end of your paper rather than including within the body of your 
paper because the information is helpful to your paper but not necessary (and possibly too cumbersome or  
distracting). Common appendices are lists of interview questions, extensive tables, and sample worksheets.

Your appendices begin after your References page. Each appendix should begin on a new page with an  
appropriate title (Appendix A, Appendix B, Appendix C, etc.). The title should be centered but not bold. If you have 
only one appendix, label it Appendix. Label the appendices in the order in which they appear in your paper. 

When you mention the appendix within your essay, you should refer to it like this: 

See the list of interview questions in Appendix A. 
A questionnaire was developed to identify these common traits (see Appendix B). 
Appendix D contains the worksheet used with participants. 

FAQS

Tables and Figures [5.01-5.30]
Use tables and figures sparingly, and only if the information contained in them is essential for understanding the 
text of your paper.   Mention the table or figure at the appropriate point in the text.  Refer readers to the table or 
figure with words such as: 

As shown in Table 2, the results were....

The configuration of parts (see Figure 1) depended upon....

Numbering and Placing Tables and Figures
• Assign numbers to tables or figures in order of their appearance in the text, and number them separately 

from one another (i.e. Table 1, Figure 1; [5.05]).
• Provide a title [5.12] for each table and place the title above the table, after the table number. 
• Provide a caption [5.23] for each figure and place the caption beneath the figure, after the figure number. 
• APA Style places tables and figures on separate, unnumbered pages after the Reference page. However, 

many University programs prefer that each table and figure appear in the text at the point where it is first 
mentioned. Check with your instructor, advisor, or program director for the preference of your program.

• If the table or figure appears in an appendix, the appendix letter appears before the number of the table or 
graph, e.g., Figure A2.   

• In APA Style, tables may have horizontal lines but not vertical lines. Lines should only be used for clarity.
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Tables and Figures [5.01-5.30], continued

Citations for Tables and Figures 
Doctoral students must obtain copyright permission to use tables and figures from another source in their  
dissertations, and must include a copyright permission footnote [p. 38] in their text.  For students not submitting 
papers for publication, the following guidelines are summarized from the APA manual: 

• If you obtained a table or figure from another source, you must, according to the APA manual, “give credit in 
the table or figure caption to the original author and copyright holder” (p. 128).  

• If you created the table or figure yourself, but within the table or figure you used information reproduced 
or adapted from another source, you must provide a source note (similar to a References page entry) at 
the bottom of the table or figure.  No entry is needed on the References page unless that source was cited 
elsewhere in the paper.  See 5.16 for examples of table source notes and 5.23 for examples of figure source 
notes.

Tables may have 
horizontal lines only 
in APA Style, but this 
table has no lines 
because none are 
needed for clarity. 

This table uses 
a sans serif 
font for both 
clarity and to 
differentiate 
it from Times 
New Roman, 
which would be 
used in the rest 
of the essay. 

Your title should be 
specific enough for 
your reader to know 
what is presented in 
your table but should 
not repeat information 
in the table itself. 

Sample Table
The table number goes above the title of the table. The title 
should be in title case (see p. 5) and in italics. 

Sample Figure

This is where you would 
include any citation 
information if you are 
reproducing an image 
found elsewhere. 

This is where 
you include 
the figure 
number in 
italics followed 
by a period. 

The most important 
thing when creating 
figures is clarity, so you 
can use sans serif text 
and alternative spacing 
to present the  
information as clearly  
as possible. 
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Part Two: Crediting Sources

Why We Credit Sources
You need to credit sources for several reasons, and understanding these reasons will help you to know what  
sources to cite and how to document them. However, occasionally programs at SGPP will require departures from 
APA Style. Ask your program faculty if they require any departures. 

Academic Ethics
Honesty and fairness require you to let your readers know whose words or ideas you have borrowed. Even 
when you put a direct quote in your own words by paraphrasing, you are still obligated to identify the 
source. 

Scholarly Credibility
All research is founded on or related to previous scholarly work. Therefore, you need to relate your ideas to 
what has been written before. Crediting this previous work establishes your credibility and provides context 
for your ideas.  

Source Retrieval
For various reasons, readers may want to view the sources you used in a piece of writing.  You are  
responsible for providing sufficient documentation in a systematic way (e.g., in APA style) so that readers 
can retrieve the information being used. 

Where to Credit Sources
Sources are credited in two places:
1. Give a short citation in the body of your paper, by author’s last name and year of publication (in parentheses).  

The purpose of citing sources in the body of your paper is to lead readers to the full reference entry, provided 
on the References page at the end of the document.

2. Give a full reference entry on the References page at the end of your document, where you will provide (a) 
author, (b) publication date, (c) title, and (d) publisher information. List the references in alphabetical order 
by the author’s last name.

How to Begin
Compose your References page as you do your research for the following reasons:

1. Creating the APA reference entry helps you understand your source—who wrote it, when it was published, 
and who published it.

2. When you compose your reference list entry, you will recognize if a crucial piece of source information is 
missing.  You can then decide whether to locate the missing information or avoid using the source.

3. You will know how to cite the source in the body of your paper.  The first two elements of the References 
page entry (author name and date) tell you how to write the brief citation in your paper.  

Timesaving Advice
Many electronic academic databases provide preformatted APA references that you can copy and paste to your own 
References page.  Some of the references may contain APA errors that will require formatting adjustments on your 
part, but copying and correcting the references as needed will take less time than typing all the reference  
information yourself. 

N
O

TE
S
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Primary and Secondary Sources [6.17]
A primary source is the originator of the information—the source in which the information was first expressed or 
published.  Sigmund Freud, for example, was the primary source for the information in his work, Civilization and 
Its Discontents, written in 1930.  

However, you almost certainly did not read that book because it was published in Europe and written in German.  
Unless you are an advanced student or practitioner, you probably read about Freud’s work in another publication—a 
textbook or other book like Breger’s A Dream of Undying Fame: How Freud Betrayed His Mentor and Invented 
Psychoanalysis.Breger would be a primary source for his own ideas or opinions, but he would be a secondary source 
for Freud’s ideas (Freud is the primary source for Freud’s ideas).  

When to Use Secondary Sources
Use secondary sources when the primary source is not translated into English, when you need to discuss reviews 
of the primary source material, or when the primary source information is not essential to your purpose. In all 
other circumstances, avoid secondary sources when possible.  When you rely on a secondary source, you raise the          
question of why you didn’t seek the original.  Furthermore, you are forced to rely on the interpretation of the                    
secondary source author.  You will pass along any errors he or she made in presenting the primary source.             

If you did read a primary source in a translation, you can still cite it as a primary source.  In the case of Freud, 
for example, you can cite Freud as a primary source.  However, you will need to identify the translator and the 
re-publication date on your References page.  For your in-text citation, give both the original publication date and 
the translation publication date.  

The chart below shows the differences in both References page citations and in-text citations for primary and                
secondary sources.

LINKS
Find more information on tables and figures at the following links: 

Navigating Copyright for Reproduced Images
Navigating Copyright: How to Cite Sources in a Table
Quick Answers—Formatting
How to Format Tables and Figures 

http://blog.apastyle.org/apastyle/2016/01/navigating-copyright-overview.html
http://blog.apastyle.org/apastyle/2016/06/navigating-copyright-how-to-cite-sources-in-a-table.html
http://www.apastyle.org/learn/quick-guide-on-formatting.aspx
http://tcwrite.smumn.edu/wp-content/uploads/2017/08/Formatting-Tables.mp4
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References Page
 

References Page Format [6.25]
• The References page begins at the top of a new page following the last page of the body of your paper. 
• After typing the title References (centered, not bold), but before typing the first entry, set up automatic 

hanging indents, which you can learn to do here. 
• Alphabetize the entries by the last name of the first author listed on the source, using the Sort Icon on the 

Home tab. 
• Note that initials, not first names, are used. 
• For guidance on ordering the entries when authors’ last names are the same, see p. 182 of the APA 

manual. 
• The References page is double-spaced throughout.  Do not place an extra line between entries.
• References are not numbered or bulleted.
• The References page and the in-text citations must correspond (except for personal communication and 

secondary sources).

References Page Basic Format [6.27-6.31] 
APA is easier to learn when you recognize patterns of rules.  Instead of trying to remember dozens of individual 
examples, learn the four basic elements that comprise all source references:

Element 1: The  Author Element [6.27]
The author may be a single individual, several individuals working in collaboration, an organization, a corporation, 
a government agency, or other group.  Place a period at the end of the element, regardless of the type of author. 
The following are examples of author elements:  

American Cancer Society. 

Ferris, D. 

Internal Revenue Service. 

West, S., Beckman, T., Vonk, J., & Jett, S. E.  

Organization

Individual

Government Agency

Individuals in collaboration/co-authors

In the rare case in which the author of a source is not identified, move the work’s title into the author position on 
the References page and alphabetize by the title’s first word (skipping A, An, or The).To cite the source in the body 
of your paper, substitute the first word of the title in place of the author’s name, typing that word either in italics 
or placing it inside quotation marks, depending on the type of source (see Element 3).  

Element 2: The Date Element [6.28]
The date is usually expressed as the year of publication and is placed in parentheses after the author element. 
However, if a month and day are provided—and if no volume number is given—include the month and day after the 
year.  The date element cannot be left blank.  If no publication year is provided, type the letters n.d. inside  
parentheses.  Place a period at the end of the date element.  Here are examples:

Year of publication
Month and day provided by 
publisher, but no volume 
number provided.

No publication date was provided by the publisher or website.

(2016).  

(2012, May 19).   

(n.d.).  

If you are not sure about the publication date, consult a librarian or a Writing Center consultant.
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Element 3: The Title Element [6.29]
Title elements can be of two types: (a) title of a work published inside another work (for example, a chapter inside 
a book or an article inside a journal); or (b) title of a work published by itself—not inside another work.  These two 
types of titles are formatted differently, as illustrated below.

Evaluating public programs with close substitutes: The case of Head Start.  

Focus groups as qualitative research (2nd ed.). 

Writing across borders: Students have their say [Video webcast].  

Article published in the 
journal Quarterly Journal 
of Economics

Title with form of work bracketed

Book title including edition number

In titles, include subtitles as shown above.  Include volume numbers or report numbers inside parentheses as 
shown above.  In brackets, indicate the form of work (e.g., brochure, motion picture, audio podcast) if the form 
varies from ordinary print or electronic print media (see Video webcast example above).  

Element 4: The Publisher Element [6.30]
The fourth element, publisher, varies according to type of source.  

Alcoholics Anonymous. (1972). A brief guide to Alcoholics Anonymous.  Retrieved from 

http://www.aa.org/lang/en/catalog.cfm?origpage=18&product=8

Lambert, S. (2011). Sustainable leadership and the implication for the general further education 

college sector. Journal of Further & Higher Education, 35(1), 131-148. doi:10.1080/030987

7X.2010.540319

Salkind, N.J. (2017). Statistics for people who (think they) hate statistics (6th ed.). London, 

UK: Sage. 

For a webpage, the publisher  
information element contains the 
words “Retrieved from” and the  
document’s URL (Internet address).

For electronic databases:  The publisher information for an electronic database 
source is the same as for a print source.  Do not provide the database name or 
URL.  However, if the database provides a DOI number, give that at the end of the 
reference after the period. See p. 14 for more information on DOIs.

For a book, the publisher 
information element contains: 
city, state, and publisher 
name.

For a journal article, the 
publication information 
element contains: Title of 
journal, volume number, 
issue number (if provided), 
page number range, and doi 
number (if provided).

Missing Elements [6.27-6.30] 
What happens if one of the four elements is missing?  First, try to find the source in an academic database, where 
the reference information is likely to be complete.  Otherwise, adjust as follows: 

Missing author: If the author’s name is not provided, move the title to the author position (that is, to the beginning 
of the reference) and alphabetize the reference by the title (skipping the words The, A, or An at the beginning of 
the title).  For the in-text citation, use the first word or two of the title followed by the publication year [6.27].

Missing publication date: If the publication date is missing, use the abbreviation n.d. inside parentheses in the 
place of the date, both in the References page entry and in the in-text citation [6.28].

Missing title: If no title is given (highly unusual), give a one- or two-word description inside brackets where the 
title would normally be: e.g., [Letter to the editor] [6.29].

Missing publisher information: If the publisher information given is not sufficient to allow readers to retrieve the 
source, then do not use the source.  If the source is an unpublished one, give that information after the title: for 
example, Author, X. (Year). Title. Unpublished manuscript.

Not all sources will fit neatly into APA guidelines.  If you encounter such a source, use (a) your knowledge of APA 
rule patterns and (b) your understanding of the purpose of APA citations—identification and retrievability—to find a 
reasonable solution to a References page entry question.
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Print Sources
Book

 Lazear, D. G. (1994). Multiple intelligence approaches to assessment: Solving the assessment conundrum. 

           Tucson, AZ: Zephyr Press. Capitalize only the first word, proper nouns, and the first word following a colon.

For information on citing e-books, see this link.

Book, Publisher as Author

 American Psychological Association.  (1994). Publication manual of the American Psychological                                            

           Association (5th ed.). Washington, DC: Author.

The author can be an individual or an organization. 

When the author and publisher are the same, 
use the word Author for the publisher name. 

Book, Translated

 Freire, P. (2000).  Pedagogy of the oppressed (M. F. Ramos, Trans.). New York, NY: Continuum. (Original   

           work published 1972) Provide the translator’s name after the title. 

Use the publication date of the translation, not the original. 

Chapter in an Edited Book

 Murphy, R. P., & Urquhart, A. T.  (2010).  Sexuality in the headlines. In K. P. Murphy & J. L. Pierce (Eds.),   

           Queer Twin Cities (pp. 45-80). Minneapolis, MN: University of Minnesota Press.
Do not invert the editors’ names (i.e., initials precede the last name). 

Place the authors of the chapter at the beginning. 

Periodical Article: Journal

 Rowley, C., &  Ingyu, O. (2016). Business ethics and the role of context: Institutionalism, history, and    

           comparisons in the Asia-Pacific region.  Asia-Pacific Business Review. 22(3), 353-365. 

           doi: 10.1080/13602381.2015.1129814

For multiple authors, separate each author with a comma. Use an ampersand (&) before the last author. 

In the title of the article, capitalize only the first word, 
the first word after a colon, and proper nouns.  

Periodical Article: Newspaper

 Carey, B.  (2017, January 2). ‘Fake news’: Wide reach but little impact, study suggests. The New York Times, D5. 

Provide all page numbers, including section letter, on which the article appears. 

Give the full date: year, month, day. 

Periodical Article: Newspaper Editorial

 Making art lovers pay [Editorial]. (2018, January 5). The New York Times, A26. 

When the author is not identified, move the title to the author position. 

In brackets identify the article as an editorial. 

http://blog.apastyle.org/apastyle/2011/06/how-do-you-cite-an-e-book.html
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Electronic Sources [6.31-6.32, 7.01-7.02]
Electronic sources fall into two general categories: (a) Documents from the Web (Internet) and (b) documents from 
restricted access electronic databases (such as those available through the Saint Mary’s University library). You 
must distinguish between the two.

Document From a Website

 Bagci, F., & Alrashed, E.A. (2016). Security architecture for wireless sensors.  WSEAS Transactions on

  Communications. Retrieved from 

  http://www.wseas.org/multimedia/journals/communications/2016/a325804-887.pdf

APA recommends including a retrieved from date only if the source material might change over time, as is the case with blogs and wikis. 

Do not use a 
period to close an 
entry ending with 
a URL. Do not hyphenate a URL to force a break at the end of a line. It is not necessary to break a URL to avoid white space.  

Webpages with Missing Elements
You may come across webpages that have incomplete information (remember that missing elements can weaken 
your credibility with readers; see “Establishing Source Credibility”). However, if you need to reference a source 
with missing elements, here is how to do so:

Webpage With No Author  

 Mayo Clinic. (2015, August 20). Artificial sweeteners and other sugar substitutes: Bewildered by the variety of   

  sugar substitutes available these days? Retrieved from http://www.mayoclinic.org/healthy-lifestyle/ 

             nutrition-andhealthy-eating/in-depth/artificial-sweeteners/art-20046936 

If no author is listed, then you should look for an organizational author.

Webpage With No Author or Organizational Author

For multiple authors, separate each author with a comma. Use an ampersand (&) before the last author. 

 Which artificial sweetener is right for me? (n.d.). Retrieved from 

 http://www.diabetes.co.uk/sweeteners/which-artificial-sweetener-is-right-forme.html 

If no author or organizational author is listed, begin with the title of the webpage. 

Webpage With No Date

For multiple authors, separate each author with a comma. Use an ampersand (&) before the last author. 

 Harvard Health Publications. (n.d). Cutting back on added sugar. Retrieved from 

               http://www.health.harvard.edu/staying-healthy/cutting-back-onadded-sugar

If no date is listed, then you should use the abbreviation “n.d.” for “no date.” 

Journal Article from a Website [p. 200] 

 Massaro, D.W. (2017). Reading aloud to children: Benefits and implications of acquiring literacy before 

  schooling begins. The American Journal of Psychology, 130(1), 63-72. 

  doi: 10.5406/amerjpsyc.130.1.0063
In the title, capitalize only the 
first word, the first word after a 
colon, and proper nouns.  
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Electronic Sources [6.31-6.32, 7.01-7.02], continued

ERIC Online Resources [p. 212, #62] 
ERIC (Educational Resources Information Center) contains mostly citations and abstracts, not full text documents.  
If you want the full document, you can order it from ERIC or use the location information to retrieve it yourself 
(with help from a librarian). If you cannot retrieve the full text document from ERIC and instead order it through 
a librarian or other provider, cite it like any other source of its type, without mention of ERIC (because you found 
the citation in ERIC but actually retrieved the document elsewhere).

 Miller, D. C., Sen, A., Malley, L. B., & Burns, S. D. (2009). Comparative indicators of education in the    

           United States and other G-8 countries: 2009. Retrieved from ERIC database. (ED504634)

Electronic Database (Restricted Access): Journal Article
Access to most academic databases is restricted to subscribers.  As a student, you have access to many of them 
because the Saint Mary’s University library subscribes to them.  Examples include ProQuest Education Journals and 
the databases within EBSCO Megafile. Sources retrieved from most of these databases do not require a database 
name or URL when cited. Articles from electronic databases are generally treated like print sources. Contrary to 
APA guidelines, Saint Mary’s University does not require students to provide a publisher home page URL if a DOI 
number is not provided.  If no DOI number is provided, you may simply end the reference entry after the page 
range. 

 Johnson, K.C. (2017). Citizenship versus the new civics. Academic Questions, 30(2), 134-164. 

 doi: 10.1007/s12129-017-9627-7 If no DOI number is available, end the citation with the period after the page range.  (The 
APA says to give the home page of the journal, but Saint Mary’s University does not require 
that information from students.)

DOI numbers [6.31-6.32, 7.01]
DOI is an abbreviation for Digital Object Identifier, a unique set of characters assigned to identify a source so that 
it is searchable on the Internet.  DOI numbers always begin with 10, followed by a decimal.  They can contain 
letters and symbols as well as numbers. Most, but not all, databases now assign DOI numbers to sources. In some 
databases, the DOI appears in the short citation; in others, you must click on the source title to obtain the DOI. 

To use a DOI to locate a source on the Internet: 

1. Go to your Web browser and type the following on 
the address line: dx.doi.org. 

2. When the DOI page opens, type or copy the DOI. 2

1

In newer sources, the DOI number appears with a prefix: http://dx.doi.org.  So the number may look like  
http://dx.doi.org/10.1037/a0030944 instead of 10.1037/a0030944. For your Reference page, type it either way 
(doi: 10.1037/a0030944  or  http://dx.doi.org/10.1037/a0030944) but be consistent. 
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Other Types of Sources

Motion Picture

 Anderson, W. (Producer), & Baumbach, D. (Director). (2005). The squid and the whale [Motion picture].    

  U.S.: Samuel Goldwyn Films. Describe the source form in brackets. 

Video (DVD)

 Guggenheim, D. (Director) and Parkes, W.F. & McDonald, L. (Producers). (2015). He named me Malala. [DVD].  

  UAE: Imagination Abu Dhabi FZ, Participant Media.  

Video (Retrieved from a website)

 

 Crenshaw, K. (2016, October). The urgency of intersectionality [Video file]. Retrieved from 

  https://www.ted.com/talks/kimberle_crenshaw_the_urgency_of_intersectionality#t-1726

Blog
Web blogs (Web blog posts) can be useful sources if you establish the credibility of the blog publisher.  Even if the 
blog is reliable, however, it probably exists elsewhere in a form that is more permanent and more easily verified 
than the information in a Web blog or a response to a Web blog.  

Blog Post

 Fogarty, M. (2017, August 24). ‘Important’ or ‘Importantly’?  [Web blog post].  Retrieved from  

 http://www.quickanddirtytips.com/education/grammar/important-or-importantly 

The title is not italicized because it is part of a larger blog series call Grammar Girl.

Blog Comment

 Jean, M. (2017, December 13). [Web log comment ].  Retrieved from http://www.quickanddirtytips.com/  

   education/grammar/important-or-importantly

The author did not give the comment a title, so all you need to provide is the source form in brackets.

Legal Documents 
Reference entries for legal documents are explained in the appendix to Chapter 7, pp. 216-224, of the APA manual.  
Library staff can provide assistance in locating reliable legal references.  Writing Center staff can help you create 
the references in APA style.  
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Source Credibility
Excerpted from “Evaluating Information,” a Twin Cities Library online tutorial. 

Evaluate a source’s credibility by determining if the author and publisher have the knowledge and credentials 
needed to publish the information. Ask yourself: 

• Who is the author?
• What are the author’s credentials?
• Is the author affiliated with a reputable organization, such as a university?
• Is the publisher or sponsor trustworthy?
• If the information is from a website, what is the domain name of the website?

Information found on websites can be especially hard to evaluate. Pay close attention to the author, sponsor or 
publisher, and the website domain name.
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In-text Citations

Purpose of Citing in Your Paper
The purpose of the in-text citation is to lead readers to the correct alphabetized entry on the References page. If 
you use another author’s words you must attribute the work to its original source (its author, composer, etc.).

• If you borrow an idea from, or directly quote from, another person’s work, you must cite the source of that 
idea or quote.

• Phrases borrowed word-for-word from another author must be placed in quotation marks and followed by 
the page number from the original source.

• You must cite a source even if you don’t quote directly from it.
• Paraphrase with care. Inadequate paraphrasing can be another form of plagiarism, even with documentation 

provided (see “Paraphrasing Strategies,” p. 22).  

The examples that follow illustrate variations on the same in-text citation:

Bucksch et al. (2016) found that STBs for adolescents increased two hours per day from 2002 to 2010. 

Adolescents’ STBs increased two hours per day from 2002 to 2010 (Bucksch et al., 2016). 

Relationship to References Page Entries
Remember that a References page entry has four elements: (1) author, (2) publication date, (3) title, and (4) 
publisher information.  The first two elements of the reference list entry—the author and publication date—make 
up the in-text citation.  The in-text citation must match the author (minus initials) and date of its Reference page 
entry so that readers can locate the entry.

Where and When to Cite? 
Two frequent APA questions are: How often should I cite and where should I cite? The answers depend on how you 
are using the sources. 

Running Text and Parenthetical Citations
To cite in running text means to place the author’s name in the sentence without parentheses, as illustrated below.  
(Always place date and page number in parentheses.)

The trend of decreasing physical activity lead Bucksch et al. (2016) to demand “interventions 

for this population” (p. 421).     

To cite parenthetically means to place the author’s name inside parentheses along with the date (and page num-
ber, if used), as follows: 

Currently, most teens do not get the recommended amount of moderate to vigorous physical 

activity MVPA every day (Straatman et al., 2016). 

Whichever way you cite, parenthetically or in running text, you must at all times make clear to readers the                      
sources of all your information. 
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Where and When to Cite?, continued

Discourse About Ideas
A literature review, for example, is organized by themes.  Instead of separately summarizing each article you read, 
you should write about themes that emerged from your review of the literature like this: 

Transformational leaders are recognized as those who inspire their followers to higher levels of   

performance and change.

In that sentence you are writing in your own voice, stating an assertion for which you found support in the litera-
ture.  You need to cite each source you read that supported that assertion.  A good place to cite in a case like this 
is at the end of the sentence in parentheses, like this:

Transformational leaders are recognized as those who inspire their followers to higher levels of 

performance and change (Bass & Avolio, 1993; Burns, 1978; Yukl, 1994). 

Placed in parentheses at the end of a sentence, citations are less distracting to the flow of ideas.  

Discourse About Works
If, on the other hand, you find that the entire paragraph contains ideas from the same author (in other words, you 
would be citing the same author at the end of each sentence), then you probably need to introduce the author’s 
name into the running text, where it is more noticeable, because you are now discussing the author’s work, not 
just citing the author as support for your own assertion. Note the following example:

 Pounder (2009) assumed that a university classroom could be considered analogous to 

an organization, with the professor as a leader and students as followers.  Pounder concluded 

that a transformational teaching style leads to positive student learning outcomes.  Students 

with transformational teachers are motivated to work harder (Pounder, 2009). 

According to the APA [6.11], 
you do not need to include the 
date when the name of the 
author appears in the same 
paragraph within the narrative 
of your sentence like this as 
long as it can’t be confused 
for another author; however, 
we recommend citing the 
date every time for clarity. Ask 
your instructor what he/she 
prefers.

Provide the name and date every time in parenthetical citations. 

Whichever way you cite, parenthetically or in running text, you must at all times make clear to readers the sources 
of all your information.  Frequent citations are necessary and expected in academic papers.

Vary the Citation Wording
Here are some examples of how to effectively integrate citations into your work. 

Note that each example 
here uses past tense 
when referring to sources 
(emphasized, responded, 
defined, etc.). Always use 
past tense when talking 
about  research completed. 

• Stieglitz and Hernandez (2002) emphasized that....
• Three earlier studies (Gudmund, Farrar, & McDermot, 2004; Willum, 2000; Wright & 

Formani, 2006) were inconclusive....
• According to Khali and Kozumi (2000), earlier research failed to....
• Zarweit (2007) responded, “At no time were the subjects informed” (p. 92).
• Czel (1999) defined sensation seeking as behavior that....
• ...but the results were inconclusive (Hammel, 2003).
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Citing Works by Multiple Authors
The table below explains how to cite multiple authors in running text and parenthetical citations using the phrase 
“et al.” which means “and others.”

Avoiding Anthropomorphism [3.09]

Anthropomorphism is attributing human actions to non-human nouns. Surveys, research, studies, and reports don’t 
do anything.  Their authors do. 

Not:  A survey by Biggs and McCoy (2001) reported....
But:  Biggs and McCoy (2001) reported....

FAQS

Personal Communication [6.20]
Personal communications can include e-mail, personal interviews, telephone conversations, course lectures, and 
class materials that are not accessible to the public. Personal communications are not retrievable sources, so are 
not included on the References page. However, they must be cited in the text as follows:  (J. Doe, personal com-
munication, April 10, 2012).  If the name of the person being cited is written into the running text, then it need 
not appear again in the parentheses.

N
O

TE
S
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Quoting and Paraphrasing

Quoting [1.10, 6.03-6.10]
Use direct quotes sparingly. Quoting does not indicate how well, or even if, you understand the material you are 
quoting.  Overuse of quotes, therefore, can cause you to lose credibility with your readers.  Quoting can also  
disrupt the flow of your writing; suddenly encountering another person’s writing style can be jarring to readers.

If you do quote, have a good reason to do so. For example: 
• to discuss the way an author expressed his or her ideas,
• to present a controversial or disputed statement verbatim,
• to convey precise technical data or directions,
• to produce a rhetorical effect when introducing or emphasizing a point.

Quoted text of fewer than 40 words must be enclosed in quotation marks and followed by the page number of the 
original text:

Cheak-Zamora and Thullen (2017) wrote that "education and training for providers is essential to 

ensure they understand the needs of people with DD and/or multiple conditions and are working to 

address quality and access issues" (p. 43).

Quoted text of 40 or more words should be placed in a separate, indented (block) paragraph:

Paterson and Chicola (2017) described their informal mentorship as follows: 

We co-negotiated difficult solutions to problems with our pesky “human” resources; we 

explored structural and governance strategies; and we diffused the challenges in our personal 

lives by talking with an empathetic female ally who was at the same time a professional  

colleague and friend. (p. 36) 

Quotations within a block  
quotation should be surrounded 
by double quotation marks. 

Also note that the end punctuation occurs before the 
parenthetical citation in block quotations. 

Omit the 
quotation 
marks 
around 
a block 
quotation.

Where do I use quotations and paraphrases within my own paragraphs? 

While every assignment has different requirements, in general, every paragraph should have a topic sentence, 
evidence, connections, and a concluding sentence. 
• Topic Sentence: A sentence that provides an overview of the paragraph and connects back to the main idea of 

the paper. 
• Evidence: This is usually source support in the form of paraphrases or exact quotations (with correct citations, 

of course).
• Connections: This is using your own words to provide summary, explanation, analysis, and/or synthesis of the 

source support.
• Concluding sentence: A sentence that summarizes the paragraph and/or transitions into the next paragraph.

You can learn more about paragraph organization by viewing this video. 

FAQS

http://www2.smumn.edu/deptpages/tcwritingcenter/Modules/Paragraphs-101%20output/story_html5.html
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Capitalization of Quotations
If the quote is a complete sentence, capitalize the first word. 

According to Li (2016), “Information technology is an important part in Flipped Classroom, which 

decisively influences the depth of the students’ extracurricular learning and the creation of students’ 

learning environment” (p. 1962). 

Harris (2000) remarked, “Finding information is an art, not a science” (p. 214).

However, if the quoted text is not a complete sentence or if a quoted sentence follows the word “that,” do not 
capitalize the first word or precede it with a comma.  

Quincy (2000) acknowledged that “negotiations over bride price sometimes involved more 

than the price of the bride” (p. 105).

Do not capitalize the first word of a quoted phrase (i.e., an incomplete sentence).

Bryson (2002) called the English language “a merry confusion of quirks and irregularities that often seem 

willfully at odds with logic and common sense” (p. 1).  

Sutter (1998) was fascinated with Lake Superior's ore boats and foreign freighters because they “seemed 

impossibly exotic” (p. 2). 

If the quote is interrupted, do not capitalize the first word of the resumed quote.

“People and places,” noted Zinsser (2003), “are the twin pillars on which most nonfiction is built” (p. 54).

LINKS
Check out these resources on quoting, paraphrasing, and citing: 

Quoting and Paraphrasing
Happy Holiday Citing: Citation of Classical Works
When and How to Include Page Numbers in APA Style Citations

http://blog.apastyle.org/apastyle/2015/03/when-and-how-to-include-page-numbers-in-apa-style-citations.html
http://www2.smumn.edu/deptpages/tcwritingcenter/Modules/Quoting%20and%20Paraphrasing%20output/story_html5.html
http://blog.apastyle.org/apastyle/2009/12/happy-holiday-citing-citation-of-classical-works.html
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Paraphrasing Strategies
You have probably heard that paraphrasing involves putting a source in “your own words.” Adequate paraphrasing, 
however, involves more than just replacing words in the original with synonyms, or words that are similar in  
meaning to the original. Successful paraphrasing requires you to change not only the words but also the structure 
of the original passage. 
 
There are several strategies that you can use to paraphrase your sources. You will need to use more than one  
strategy in order to avoid plagiarism. Here are the strategies: 

#1 Change word form or part of speech 
#2 Change from active to passive voice, or vice versa 
#3 Change the word order  

Note that in the following examples, each paraphrased sentence is the result of a number of the techniques               
described above. 

N
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#4 Change from specific to general 
#5 Change transitions 
#6 Replace words in the original with synonyms 
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Part Three: Using Microsoft Word for APA

Getting Started & 
General Tips

A Word on APA Format and Instructor Requirements
This section will provide you with instructions on how to format your documents according the requirements and 
guidelines of APA Style. We will also provide instructions on how to format things for which the APA has no  
requirements, like Tables of Content.

However, every instructor and assignment is different. You should always refer to your assignment sheet,  
program-specific templates, and the instructions given to you by your professor in terms of formatting. 

Writing Center Workshops
In addition to the information here, the Writing Center offers a fee-based workshop on using Microsoft Word. For 
information, visit our website and click on Appointments/Workshops. 

Before We Start

To get the most of the instructions that follow, please familiarize yourself with the following topics.

Ribbon Bar
The Ribbon Bar is how you will navigate through all of the options in Word. The diagram below will familiarize you with the 
elements of the Ribbon Bar. 

The Ribbon Bar is divided into tabs: Home, Insert, Layout,  
References, Mailing, Review, and View.

Each tab is divided into sections. For example, 
the Home tab is divided into Font, Paragraph, 
Styles, and Editing. 

The Quick Access 
Toolbar contains  
frequently used 
tools, including Save 
and Undo.You can 
add/remove items to 
this toolbar by click-
ing on the arrow. 

The Ruler lets you adjust the indentation of your text. To 
see the ruler, you might need to go to the View tab and 
check the box next to Ruler.
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Ruler
This tool allows you to indent right from the main screen. 

Use the upper triangle to indent the first line of a 
paragraph. 

Use the lower triangle to indent subsequent lines 
of a paragraph. 

Use the square to indent a block of text.

Show/Hide
This function allows you to see hidden formatting codes, which is helpful when you need to correct or modidy for-
matting. 

indicates you pressed ENTER to start a new paragraph. 

Common codes include:

indicates that you pressed the space bar. 

indicates you pressed Tab. 

indicates you inserted a Page Break. 

Find this button within the Paragraph section of the 
Home tab. When you press this button, you’ll see all of 
the formatting codes within your essay. 

Undo

The Undo button is located in the Quick Access Toolbar and 
allows you to cancel your last command(s). 
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Initial Setup of 
APA Papers 

Set up APA format before you begin typing. You can set formatting for one paper, or you can change the default 
so that the formatting stays set for all future papers (you can always change this at any time), which is what the 
directions below will explain how to do. 

Font
You should use Times New Roman 12-point font in all of your papers except for in certain kinds of figures. Your font 
should always be black. 

In the Font section of the Home tab, click on the 
arrow in the bottom, right-hand corner. 

In the Font menu, choose:
 Font: Times New Roman
 Font style: Regular
 Size: 12

To save these settings for this paper only, click on OK.  

To save these settings for all future papers, click on Set As 
Default. 
Select “All documents based on the Normal template” and then 
click OK.

1

2

4

3

1

2

3
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4
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Margins
Your margins should be set to 1 inch throughout your essay in APA Style. 

In the Page Setup section of the Layout tab, click on the 
arrow in the bottom, right-hand corner. 

Under the Margins tab of the Page Setup 
menu, make sure all four margins are set at 
1 inch. 

To save these settings for this paper only, 
click on OK.  

To save these settings for all future papers, click on Set 
As Default.
Then click YES.

4 3

1

2

3

5

4

5

1
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LINKS
Watch the videos below to learn how to do some of the common APA Style 
tasks in Microsoft Word: 

Page Numbers and Headers
Table of Contents
Tables and Figures
References (including Hanging Indent)

http://tcwrite.smumn.edu/wp-content/uploads/2016/09/MSWord07-page-numbers-and-headers-1.mp4
http://tcwrite.smumn.edu/wp-content/uploads/2016/09/Table-of-Contents-1.mp4
http://tcwrite.smumn.edu/wp-content/uploads/2017/08/Formatting-Tables.mp4
http://tcwrite.smumn.edu/wp-content/uploads/2016/09/MSWord07-references.mp4
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Line Spacing, Indents, Text Alignment
You should change these settings before you start typing. In APA, your writing should be aligned left (except for 
centered headings and titles) and your entire document should be double-spaced. 

In the Page Setup section of the 
Layout tab, click on the arrow in the 
bottom, right-hand corner. 

Set Alignment to Left. 

Set Indentation to 0” both left and right. 

Set Line Spacing to double. Set Before 
to 0 and After to 0. 

To save these settings for this paper 
only, click OK. 

To save these setttings for future                         
papers, click on Set As Default, choose 
the appropriate option, and click OK. 

1
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Page Numbers and Page Headers
APA Style calls for a page number and page headers, both inserted into the header box, 0.5 inches from the top 
edge of each page, including the title page. Check to see if your program has different requirements. 

From the Insert tab, click on the arrow 
next to Page Number in the Header & 
Footer section. 

Click on Top of Page and then Plain 
Number 3. This will insert the page 
number on all pages within your  
document.  

Within your header (you can always double click to access it), put your cursor in front of the page number, 
type a shortened version of your title in all caps, and press TAB twice. Select all elements within the header 
and change the font (if needed) to Times New Roman 12-point font. Then double-click below the dotted line 
to exit your header.

1
1

2

3

2
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Running Head
If your instructor requests the traditional APA Style header with “Running head:” on the first page, follow the  
instructions below. 

Insert your page number and header as shown on the previous page. 

Click on the arrow within the Page Setup 
section of the Layout tab.

In the Page Setup menu, click on the 
Layout tab and then check the box next to 
“Different first page.”

Click on OK.

You can now type into the header on the first page of your document, but the headers on subsequent 
pages will stay the same. Double click in the header space on your first page and type Running head: 
followed by your title in all caps. Press Tab twice and type 1 for the page number. Change the font to 
Times New Roman 12 as needed. 
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Page Breaks
Word automatically inserts page breaks as you type; however, you will need to manually insert page breaks at  
certain points in your essay—after your title page and before your References page, for example. You shouldn’t 
press Enter multiple times to do this because you will create formatting issues. Instead, follow the steps here. 

From the Insert tab, click on Page Break. 

OR 

Press CTRL+Enter when typing. 

Place the cursor at the start of the paragraph 
you would like to be on a new page. Here, the 
cursor is right  before “References.”

N
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Table of Contents: Dot Leaders
There aren’t any APA guidelines for a Table of Contents; however, the instructions below will help you create one if 
your instructor requires it. You must set up dot leaders for your tab stops—this will insert the dots that connect the 
labels with the page numbers. Do not press the period key (.) repeatedly to do this as your numbers won’t line up 
correctly. 

Click OK.

Type the title “Table of Contents” (no 
quotation marks, centered) at the top of 
your page. 
On the Home tab, click on the arrow in 
the Paragraph section
Then click on Tabs... at the bottom of the 
Paragraph menu.

In the Tabs menu, click on Clear All.

Type “6.5” into the Tab 
stop position. 

 Select Alignment Right. 

 Select Leader 2.

Click Set. 
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Table of Contents: Dot Leaders, continued

Type your first label for your Table of Contents. Press Tab once. A row of dots will appear, and then you can enter 
the page number. 

Table of Contents: Subheadings
You cannot indent subheadings within your Table of Contents using Tab. Instead, you should use the Increase                  
Indent icon on the Home tab.
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Formatting Within 
the Paper

This section will help you format various part of your essay, including block/indented quotations and headings. 

Block/Indented Quotations
While you should use exact quotations sparingly, if you use a quotation of more than 40 words, you will need to 
format it as a block or indented quotation as shown below. 

To format your quotation correctly: 
1. Type the quotation. It should be double-spaced like the rest of your paper. 
2. Highlight the quotation.
3. Click on the Increase Indent icon in the Paragraph section of the Home tab. 

Is Grammar Check always right? 

The grammar checker can be a useful tool, but it cannot think the way a human does. If you type  
something that doesn’t fit one of the grammatical patterns stored in the grammar checker’s memory, the grammar 
checker will give you an “alert,” meaning it can’t find a matching pattern.  

Think of the alert as a question rather than a command. It is asking, Is this the pattern you really want?  For  
example, the grammar check usually alerts writers to use of the passive voice because passive voice is  
usually best avoided. However, it is not necessarily wrong, and on occasion it may even be preferred to  
active voice.  You must decide to keep, discard, or modify text that sets off the grammar alert.  

The grammar checker will also not mark things like incorrect usage. For example, if you accidentally type “field” 
instead of “filed,” the grammar checker won’t highlight this. The grammar checker may also mark things like proper 
nouns as incorrect because it doesn’t recognize them. In short, this is a good tool, but don’t change something just 
because the grammar check highlighted it.  

FAQS
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Word Count
You can always see your word count at the bottom, left-hand corner of your screen. 

To see the number of words in a section, highlight the text. You’ll then see a 
ratio of highlighted words to total words. 

You can also see your word count and 
additional information if you click on 
Word Count in the Proofing section of 
the Review tab. 
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Bulleted or Numbered Lists

1. Click on the Bullet icon                 or the Number icon                in the Paragraph section of the Home tab.  

Use numbers when the order of the items is 
important. For example, when you are listing 
the steps in a process. Use bullets when the 
order isn’t important. 

2. Type the list and then highlight it.
3. Click on the Increase Indent icon to indent the list 0.5 inches.

N
O
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S
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Orphan Headings
Headings should remain with the text that follows them. This means that no headings should be “orphaned” on the 
bottom of the page. 

Put your cursor in front of the first letter of the heading.

On the Home tab, click the arrow in the bottom, right-hand               
corner of the Paragraph section. 

In the Paragraph menu, click on the Line 
and Page Breaks tab. 

Select “Keep with next.” 

Click OK.
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Irregular Line Spacing
If you cut and paste text from various documents, you may end up with irregular line spacing. For example, you 
might have a triple space between paragraphs rather than a double space. Let’s learn how to correct this here.

Highlight the text with the issue OR click on the arrow next to Select to                                   
Select All if you have multiple areas with this issue. 

On the Home tab, click the arrow in the bottom, right-hand corner of the                      
Paragraph section. 

In the Paragraph menu, set the Spacing to 0 pt for both 
Before and After. 

Click OK.
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References Page

This section will address the formatting of your References page, including hanging indents and alphabetizing. 

Hanging Indent
Do not create hanging indents manually—doing so will cause formatting issues if you revise anything on this page. 
You should use the process below to create hanging indents instead. 

In a hanging indent, the first line of 
each citation is aligned left, and all 
subsequent lines are indented.

Click on the arrow in the bottom, right-hand corner of the 
Paragraph Section of the Home tab. 

In the Paragraph menu, under Special, select 
Hanging, and change the spacing to 0.5 
inches.

Click OK.
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Copy & Paste APA References From a Database
You can copy and paste reference citations from a database to save time; however, you need to do it correctly to 
avoid any formatting errrors. You should do this process after you have formatted your References page hanging 
indents, margins, font, etc. 

In Word, right-click and then select the Merge Formatting                          
option under Paste Options. This will paste the entry into your 
References page.
You should review the entry for correctness, especially in 
terms of capitalization.

1

From the Detailed Record 
page in SuperSearch, click 
on Cite.             

1

This will pull up a 
list of entries in var-
ious styles. Scroll 
down to find APA.

Highlight this entry, 
right-click and 
select Copy.      
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Alphabetize Your References Page Entries
Once your References page is complete, you can alphabetize your References page entries easily, using the Sort 
icon.

Highlight your entries (be 
sure to exclude the title of 
References).

Click on the Sort icon in the Paragraph 
section of the Home tab.

Under Sort by, be sure that Paragraphs 
and Ascending are selected. 

Click OK. 
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Should I keep the hyperlinks in my References page entries? 

When you type a URL (Internet or e-mail address) and press the Enter key, the URL turns blue and underlines,  
creating a hyperlink.  Hyperlinks occur on your References page when you type URLs for electronic sources.   
Hyperlinks must be converted to “normal” text: 

1. Right Click on the hyperlink (click the right mouse button) 
2. When the menu opens, click Remove Hyperlink.

URLs (Internet addresses) appear on your References page but should never be inserted as in-text citations. For 
information on citing webpages within your text, see our handout on this topic here. 

FAQS

http://tcwrite.smumn.edu/wp-content/uploads/2017/08/Citing-Webpages.pdf
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Matching Reference Entries to In-text Citations
You can use the Find tool in Word to check for consistency between your in-text citations and References page 
entries. 

Highlight the first last name in a entry 
on your References page. Be sure to 
highlight the name only. 

Click on the Find icon within the 
Editing section of the Home tab.

This will bring up the Navigivation pane, which allows you 
to see each time this name is used in your paper. 

You can click on each item or use the arrows to scroll 
through each instance and check for correctness. 
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STBS AND TEENS  8
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Sample References Page

This is an organizational author. The entries are 
alphabetized by the first letter (except a, an, the), 
so this comes first because it starts with “A.”

This source had no date, 
so “n.d.” is used instead 
of a year.

Remember that book, article, and webpage titles 
in your entries on your References page should be 
sentence case. We only capitalize the first word, any 
proper nouns, and the first word after a colon. 

These are the  
authors of one chap-
ter. These authors 
would appear in the 
in-text citation rather 
than the editors.

Only use a retrieval date for sources 
like wikis or data sets that might  
frequently change. Also, note there is 
no comma or colon before the URL. 

If a source has eight or more authors, 
list the first six names, put an & 
followed by an ellipses (...), and then 
list the very last name. The ellipses 
lets us know that there are names 
missing between the first six and the 
last name. 

The page numbers are only given here because we are citing one 
chapter. If you are citing the whole book, don’t use the page numbers. 

Remember that journal titles are title case and in italics. Journal 
volume numbers are also in italics. 
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Index

References page, continued
Copy APA reference from database, 
39
DOI numbers, 14
DVD, 15
ERIC document, 14
format and arrangement, 10
four elements of an APA entry, 10-11 
journal article, library database, 14
journal article, print, 12
journal article, website, 13
legal documents, 15
motion picture, 15
newspaper article, 12
newspaper editorial, 12
primary & secondary sources, 8
publication date, missing, 11
publisher element, 11
title element, 11
title, missing, 11
titles, how to format, 5
URLs, 40
website document, 13

Ruler bar, 24
Secondary sources, 9
Spacing

Line spacing, 3
Spacing after puntuation, 4

Table of contents, 31
indent subheadings, 32

Tables & figures, 6-7
citing, 6
format, 6
samples, 7

Title element, 11
Title page, 4
Titles, 5

capitalization, 5
in your paper, 5
on the References page, 5

URLs for websites, 40
Word count, 34

Missing elements, 11
Motion picture, reference, 15
MS Word 2007 for APA, 23-41

alignment, 27
alphabetize, 40
center, 27
quick access toolbar, 23
font, 25
grammar check, 33
headings, prevent orphans, 36
hyperlink, remove, 40
indents, 27

block quotes, 33
hanging indents, 38

line spacing
correct irregular, 37
line spacing, 27

lists, 35
margins, 26
page breaks, 30
page headers, 28-29
page number, keep off first page, 29
page numbers, 28
ruler bar, 24
show & hide, 24
table of contents, 31
undo, 24
word count, 34

Numbered lists, 5
formatting, 35

Orphan headings, 3, 36
Page breaks, 30
Page numbers & headers, 28-29

keep off title page, 29
Paraphrases, 20, 22
Periodical, 12-13

journal article, 12
journal from Website, 13
newspaper article, 12
newspaper editorial, 12

Personal communication, 19
Plagiarism, 8
Primary & secondary sources, 8
Publisher element, 11
Punctuation

spacing with, 4
Quotations, 20-21

blocked, about, 20
blocked, create in Word, 33
capitalization in, 21

References page, 10-16
alphabetize references quickly, 40
author & publisher are the same, 12
author element, 10
author, missing, 11
authors, more than two, 10
book, chapter,  12
book, chapter in edited book, 12
book, print, 12
book, translated, 12

Alignment from margin, 1
Alphabetize references, 40
Anthropomorphism, 19
Appendices, 6
Author element, 10

author missing, 11
authors, multiple, 10

Block quotes, 20, 33
Books, 12

chapter in edited, 12
multiple authors, 19
translated, 12

Bulleted lists, 5, 35
Citing sources in your paper, 17-19

anthropomorphism, 19
personal communication, 19
purpose, 17
relationship to References page, 17
running text vs. parenthetical,17-18
vary the citation wording, 18
where & when to cite, 17

Copy an APA database reference, 39
Credibility of sources, 16
Quick Access Toolbar, 23
Dash, 4
Date element, 10
DOI Numbers, 14
Dot leaders, 31
ERIC database, 14
Font, 1, 25
Format of an APA paper, 1-7

alignment, 1, 27
font (typeface),1, 25
headings, 1-3
indents, 3, 27
line spacing, 3, 27, 37
margins, 3, 26
page numbers, 3, 28
spacing after punctuation, 4

Four elements of a reference, 10-11
Grammar check, 33
Hanging indent, 38
Headings, 1-3

examples, 1-2
about, 1
in the appendix, 6
introduction and conclusion, 2
prevent orphans, 3, 36

Hyperlink, turn off, 40
Hyphen, 4
Indents, 3
Legal documents, 15
Lettered series, 6
Library databases, reference, 14
Line spacing, 3, 27, 37
Lists

bulleted, 5
how to format in Word, 35
lettered, 6
numbered, 5

Margins, 3, 26



     

How do I: 
Set up my header/page numbers? p. 29
Format a hanging indent? p. 38
Cite a secondary source? p. 9
Paraphrase effectively? p. 22
Format my Table of Contents? pp. 31-32

What do I do if: 
A source has no author, date, or title? p. 11
I want to include a table? pp. 6-7
I need to alphabetize my References page? p. 40

Where can I see: 
A sample References page? p. 42
A sample table or figure? pp. 6-7
Examples of correct headings? pp. 1-3
An example of how to integrate a quotation? p. 18
A title page? p. 4

What if I need help? 
Make an appointment for a consultation 

at tcwrite.smumn.edu, 
email us at tcwrite@smumn.edu, 

or call us at 612-728-5154.

© 2018 The Writing Center, Saint Mary’s University of Minnesota Schools of Graduate and Professional Programs
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